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Satmaster Pro Mk10.x Quick Start User Guide
Satmaster Pro runs on Windows XP to 11 inclusive. This is a quick start guide in 
using the software. More detailed information is supplied in the help file. The 
software assumes a basic familiarity with link budget parlance also some 
described functions may be disabled in demo versions.

For sales/support enquiries relating to this product please contact:: 
Arrowe Technical Services using the email contact form on any of the website 
URLs below.

https://www.arrowe.uk
https://www.arrowe.com
https://www.satmaster.com

Overview
Satmaster Pro is a general purpose tool for the satellite industry. Signal 
propagation, antenna aiming (including dual feeds), link budget analysis and 
solar outage prediction provide the backbone to the package. At the end of this 
document, a method is described for paired carrier link budgets.

Other inclusions are integral magnetic variation calculation and tens of thousands 
of stored town/city co-ordinates for over 200 countries. All the non-file based 
input forms are pre-filled with example data, which may be changed as  required.

Installation
Download the installation file from the website, unzip it, then run setup..exe.  
Follow the on-screen instructions and respond to prompt for the destination hard 
disk folder.

The install program copies files to your hard disk and sets up a program menu 
group containing Satmaster Pro.  You run the program by double clicking the 
desktop shortcut or selecting form Windows program menu. Satmaster Pro is 
uninstalled using the “Add/Remove Programs” tool in the Control Panel.

Running Satmaster Pro
Satmaster Pro is designed to be simple to use and works just like any other 
Windows application with  menus, speed buttons, forms,  windows, a status bar 
and a HTML help system.

The program starts with a main application window, menu and toolbar.  The 
toolbar gives access to the File, Edit, View, Map, Graph, Table, Calculate, 
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Option, Window and Help menus.

The data file types Satmaster Pro uses are:

● Look Angle Files (*.ang) – Antenna aiming.

● Dual Feed Files (*.duo) – Dual feed calculations.

● Link Budget  (*.glb) – GEO full up-down digital link budget (bent-pipe)

● Country Files (*.twn) – Country files with town/city data

● Satellite File (*.geo) – The GEO satellite list

● Solar Outage (*.sun) – Sun outage results file

● Bitmap Files (*.bmp;*.gif;*.pcx;*.tif;*.jpg) – Footprint maps etc.

● Rain Attenuation Files (*.atn) – Rain attenuation data files

● Regenerative Uplink Budget (*rup) – Digital budget for regenerative 
transponder uplinks (GEO or NON GEO supported).

● Regenerative Downlink (*rdn) – Link budget for regenerative transponder 
downlinks (GEO or NON GEO supported). This module may also be used 
for quick TVRO antenna sizing where a bent pipe transponder is operated 
near saturation,

● Link Budget (Non GEO) (*llb) – Link budget for HEO/MEO/LEO satellites 
(bent-pipe)

● Two Line Element Files – NORAD TLE files (*.tle)

You may open any mix of these file types and display several windows 
simultaneously to compare different links and their performance characteristics.

 The database files, (*.geo) and (*.twn), are fully editable and may be modified or 
appended by the user at any time.  To save time the latest file ‘satlist.geo’ can 
also be downloaded from our web site without login.

System Clock
Ensure the date of your system clock is correct, so current magnetic variation 
valuesare correctly calculated. It should be noted that the best possible accuracy, 
using any global model, is + or - 0.25 degrees.

Data Conventions
Satmaster Pro requires the following rules to be observed when entering or 
interpreting values of latitude, longitude or magnetic variation.  All units are 
degrees unless otherwise stated.

• Latitudes NORTH  suffixed by N (eg 53.33N)
• Latitudes SOUTH  suffixed by S  (eg 10.34S)
• Longitudes EAST suffixed by E  (eg 19.2E)
• Longitudes WEST suffixed by W (eg 3.1W)
• Magnetic variation EAST  suffixed by E (eg 3.0E)
• Magnetic variation WEST suffixed by W (eg 3.0W)
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Latitudes and longitudes, are usually obtained from maps and atlases in degrees 
& minutes format, whilst satellite longitudes are often quoted in decimal degrees.  
When using Satmaster Pro, always use decimal degrees for all input fields with 
the exception of editing country files outlined below.

A conversion facility is provided under the “Calculate” menu to convert from the 
degrees and minutes form to degrees.

When editing country data files it is often more convenient to enter and check 
data in degrees and minutes format.  Satmaster Pro automatically converts 
degrees and minutes format to decimal degrees as and when the data is used.

Help Facilities
A help system is employed using a variety of methods listed below:

• Each form has its own help button which may be clicked to display 
detailed information about input values.

• Press F1 key for context sensitive help on any input field.
• Click the 'question mark' (?) button on top right of a form then click the 

field of interest.

Input Forms
Satmaster Pro makes heavy use of input forms. This makes input validation 
comprehensive and allows the user to call up help as necessary for assistance 
with range, type and definition of input parameters.  All input is validated in an 
attempt to make the program more crash-proof.

You may cancel (close) a partially completed form at any time and provided you 
do not close it's associated window,  data will be retained on clicking the “Edit 
Active Document” button again. You may also save incomplete forms.

Toolbar
The toolbar buttons duplicate the more frequently used menu selections.  The 
most useful is perhaps the ‘Edit Active Document” button, third from left, which 
avoids some menu thrashing. In order, left to right, the buttons represent:

● Load an existing file

● Save file

● Edit active document

● Copy all; Print

● Print preview

●  Tile or cascade open windows;

● Help. 

Getting Started
For any opened file type bring up the input edit form by clicking the “Edit Active 
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Document” button shown below. 

Complete the form then click its OK button to  calculate. Provided you do not 
close the associated window, you may also leave any, file based, input form at 
any time without loosing partially completed data by clicking the Cancel button. 
To restore the form click the “Edit Active Document” button again. The edit 
button, shown above, is easily the most convenient button on the toolbar.  You 
can edit any file window, at any time, by clicking this button.  Pressing the “F12” 
hot key performs the same action.

Default parameter sets are not necessary, simply load a parameter file that is 
closest to that needed, edit the parameters that are different then save it under a 
different file name This is much quicker than starting with a new blank file.

When text, image, graph or table is displayed in an active window, simply click 
the “Copy” button to transfer the entire contents to the clipboard in a single 
operation.  The clipboard contents can subsequently be pasted into other 
documents or spreadsheet as tab delimited text for editing.

Satmaster Pro can read BMP, TIFF, GIF and JPEG formats, which could be used 
to display EIRP, G/T and SFD footprints (for copyright reasons these cannot be 
redistributed with Satmaster Pro.

Options Menu
The  first thing to do is enter your company name into the Set-up dialog box.  
This text is inserted in all printouts and display. Click on ‘Options’ from the menu 
bar then select ‘Setup’.  The persistence of the set-up data  is selected using one 
of three "Persistence" radio buttons shown below.

● ‘This session only’ - any changes made to the set-up dialog are temporary 
and last only for the duration of the current session. 

● ‘All sessions’ - any changes made to the set-up dialog take effect 
immediately but are also saved to disk as the file ‘satmast.cfg’. Next time 
you run Satmaster Pro, these values and selections will be restored.

● ‘Restore defaults’ - this restores the original  default settings.

A checkbox option is provided for saving all data present in the input forms under 
the Table, Graph and Calculate menus at shutdown.

File Menu
Use this option to save, open, print, or create new files.  There are many different 
file types.  If you select File|New the appropriate form is displayed for the file type 
selected.  Simply complete it referring to Help where necessary.

To open an existing file select ‘File|Open’ to display the open dialog then select 
the file type from the ‘List Files of Type’ section.

©2018 Arrowe Technical Services                       4                                      



Satmaster Pro User Guide

Editing Files
The following sections show how to produce a selection of files followed by how 
to create and edit the country and satellite databases.  Creating and editing any 
other file type follows the same method.

Look Angle Files  (*.ang)
This file type is used to calculate antenna installation settings.  Click on File|New 
then select “New Look Angles” from the menu to display an empty ‘Look Angles’ 
window and input form.  Later you may probably find it more convenient to 
amend a previously saved file and just alter the parameters for your particular 
location.  Remember to save it under a different filename though.

For convenience, you may transfer data from the country town/city database into 
the ‘Look Angles’ form with the ‘Site’ button. Clicking this button will bring up an 
‘Open Country Data File’ dialog to select a particular country file.  Entering a 
letter from the keyboard can quick scroll the list box to the appropriate 
alphabetical point.

Once the country file has been selected, a list box is displayed to select a town or 
city from the file.  Entering a letter from the keyboard quick scrolls the list box to 
the appropriate alphabetical point.

Similarly, data from the satellite database file ‘satlist.geo’ may be transferred into 
any form by clicking the ‘Satellite’ button and double clicking on the required 
satellite in the list box. 

When the ‘Look Angles’ form is completed, click the OK button to trigger the 
calculation.  You may also close the input form without loosing any entered data 
by clicking the ‘Cancel’ button provided you do not close the associated display 
window. By reactivating the accompanying window by selecting ‘Edit Active 
Document’ from the ‘Edit’ menu or clicking the toolbar button you may finish 
entering data. This facility is also applicable to all the link budget and solar 
outage forms.

Once the calculation is triggered, the associated window displays the calculated 
results and the parameter file may be saved with the ‘ang’ extension.  To do this, 
select ‘Save As’ from the ‘File’ Menu and enter the fileneme.  It should be pointed 
out, that only the input parameters are saved, not the text itself.  If you wish to 
save the text portion as a simple text file then select 'File|Save As Text’ or 'File|
Save as HTML' . You may also copy the text to the clipboard as tab delimited text 
for directly pasting into a spreadsheet or similar application. 

Link Budget Files
There are several types of link budget file.  The regenerative downlink module 
has a dual purpose. It may also be used for quick TVRO antenna sizing providing 
the bent pipe transponder is operated near saturation. Obviously, by performing a 
downlink calculation in isolation you need to make a few assumptions but for 
broadcast TV reception the error is small and adequate for sizing downlink 
antennas. For satellite TV, the uplink side often uses UPC (uplink power control) 
or ALC (automatic level control) in an attempt to reduce the effects of uplink rain 
on the downlink.
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The procedure for editing and completing link budget forms is similar to that of 
the ‘Look Angles’ example.  Simply complete, referring to Help as necessary then 
click the OK button to trigger the calculation.

On all link budget forms, there is an option to enter either antenna efficiency or 
gain.  To enter a gain prefix the value entered with a ‘+’ character.  This option is 
useful where the gain of the antenna is already known. Similarly,, it is possible to 
choose whether to enter a LNA/LNB noise figure or noise temperature. To enter 
a noise temperature prefix the value entered with a '+' character.

The rain models are fully automated with digital mapping, no reference maps are 
needed.

It should be noted that adjacent satellite interference (ASI) will increase as the 
antenna size reduces thus lowering C/ASI values.. With small dishes <0.5m the 
level of ASI  may dominate the link budget. 

Link Budget Files (GEO)
Use this module for the vast majority of digital link budgets. It performs up-down 
link budgets for VSAT networks,  digital links for SNG as well as most other 
applications. This module can iterate the link budget for minimum uplink power 
requirements.

To use this module open a new Link Budget (GEO bent pipe) file or, perhaps 
easier, modify an existing file.  Complete the form referring to ‘Help’ as 
necessary.

Click the tabs to select portions of the form. The overall design relies only on 
information easily available or estimated.

There is “Reverse” button on the input form which toggles (exchanges) some site 
dependent input parameters from the uplink to the downlink. This can save some 
typing when a link budget needs to be performed for the reverse link in a network 
situation. 

Under the "Carriers and Modulation" tab you can select from BPSK (1 
bit/symbol), M-(A)PSK or M-QAM modulation.  If 1bit/symbol  is selected always 
enter M=2 since it is a binary signalling system.

Other Link Budget Files
With the non-geo satellite link budgets you will need a figure for range and 
elevation to create a “snapshot” link budget. Otherwise operation is very similar 
to those already described. Remember to press F1 on any input parameter for 
context sensitive help.

Common Causes of Failure to Balance a Link Budget
There are three main reasons why negative margins or failure to balance a link 
budget may occur while using Satmaster Pro.

1. Ensure you have entered the information rate in units of Mbps not kbps. This 
is a common mistake.
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2. Entering an excessive signal availability value. If in trouble always start off with 
a low availability of, say, 99.3% and work upwards.

3. Entering too low a value for interference fields. The lower the numerical value 
entered, the higher the interference.

Dual Feed Files
These files are similar to look angle files but also calculate the relative satellite 
spacing and (x,y) feed mounting positions for dual feed systems. Use the 
resulting antenna efficiency reduction to perform a second link budget if required. 
Repeat as often as necessary for multiple feed systems.

Rain Attenuation Files
This module calculates the attenuation, system noise increase and downlink 
degradation due to rain for any given slant path. 

Solar Outage Files
Twice a year the sun crosses the equator and traces an arc that is directly behind 
the geo-arc of satellites.  Noise from the sun, within capture of the antenna’s 
beamwidth, disrupts reception.  The effect is known as a solar outage.

Satmaster Pro employs a complex algorithm to calculate the sun's position rather 
than rely on approximation methods. Events are listed in date order and grouped 
into early and late seasons.

Sun files (*.sun) are used to store solar outage input parameters.  Completing a 
solar outage form is similar to that of previous examples, the parameter files can 
be opened and saved in a similar manner.

Within the edit form select either ‘standard’ or ‘wide’ beamwidth.  The region of 
sky scanned depends on the specified antenna beamwidth of the receive station.  
If an even wider ‘window’ is required, reduce the antenna diameter parameter to 
increase the beamwidth.  The default prediction is accurate to the ‘nearest 
minute’, however there is a ‘nearest second’ option.

Clicking the ‘OK’ button starts the calculation.

Important Note: If the program does not find any outages, the most likely reason 
is that the local time zone entered, relative to the Greenwich meridian, is 
incorrectly input.  Time zones west of the Greenwich Meridian are entered 
negative and time zones east, positive.  Even if you require results in GMT, the 
local time zone must always be entered correctly.  Do not include any 'daylight 
saving' schemes.

How to Edit Country Data Files
Country data files contain latitude and longitude co-ordinates for major towns and 
cities.  There are about 250 country files with up to 1800 entries in each.  This 
data is transferred to forms using a ‘Site’ button. 

Select ‘File|New Country Data’ to start a new custom file.

To edit an existing country file:
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1. Click ‘File’ then ‘Open’.  The Open dialog is displayed.
2. Select ‘Country Files (*.twn) from the ‘List Files of Type’ pull down listbox.
3. Select the file of the country of interest (e.g. United Kingdom.twn).  A window 

should appear containing a list of all the towns and cities currently stored.
4. Click the toolbar edit dialog button or select ‘Edit Active Document’ from the 

‘Edit’ menu.  The ‘Edit Town/City Data’ dialog appears (shown below).
5. Click on the name of the town/city you wish to amend then click the modify 

button (double clicking on the town/city goes straight to modify).  The ‘Modify 
Town/City Record’ dialog appears.  You can also change the name of the 
country as it appears on reports and printouts by clicking the ‘Edit Country 
Name’ button.

6. Edit the Town/City name and co-ordinates as necessary then click the ‘Done’ 
button.

Modify town/city records by clicking the ‘Modify’ button or add records by clicking 
the “Add” button. Click the “Done” button after modification then save the file 
using 'File|Save As' from the program’s menu.

How to Edit Satellite Data File
A database of geo-stationary satellites, their locations and active bands are 
stored in a single file called ‘satlist.geo’.  Select File|Open then select ‘Satellite 
File (*.geo)’ from the ‘list files of type’ drop down list box in the ‘Open’ file dialog.  
Select the file ‘satlist.geo’ and its contents will be displayed in a window.  Click 
the edit toolbar button to edit in a similar manner to the town/city files.  This file is 
edited in a similay way to the Country files described above. 

Display Footprint Maps (*.bmp; *.gif; *.tif; *.jpg)
Footprint maps (not included in the package for copyright reasons) may be 
opened by selecting ‘File’|’Open’ then listing ‘Bitmaps *.*’ in the ‘Open File’ 
dialog.  A more convenient way is by selecting ‘Map|Display Footprint Map’  from 
the menu bar. Footprint maps may be obtained from satellite operators, web sites 
or scanned.

Map Menu
There are two reference diagrams under the 'Map' menu, one is called ‘Polar 
Mount Diagram’ and the other is ‘Polarization Offset Diagram’.  These diagrams 
clarify the angle terminology used. There are also reference maps for time zones 
and ITU regions.

Graph Menu
The ‘Graph’ menu allows you to plot various relationships between parameters 
and may be useful for reference purposes.  Select the required graph from the 
‘Graph’ menu and fill in the corresponding form.  Any data entered into these 
forms are persistent. If the current data is not needed, click the input form's 
‘Clear’ button and reenter.  Context sensitive help is available on all fields. Each 
graph is plotted in a new window and may be printed or copied to the clipboard. 
The graphs show general trends, they are not intended for accurately extracting 
values.
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Table Menu
Select the required table from the ‘Table’ menu, fill in the associated form and 
click the OK button.  As described in the previous section input data can be 
persistent. The table of tab delimited results are displayed in a new window and 
may be printed, copied to the clipboard or saved as text or simple HTML.

Solar Event Tables
There are two types of solar event table generated by selecting from the ‘Table’ 
menu.  The first is ‘Solar Transit Times’ and the second is ‘Sun/Satellite Azimuth 
Coincidence’.  The former is useful for accurately locating true north/south for 
installing polar mount antennas similat to using  the 'stick in the ground' shadow 
method.  The latter may be useful for locating the true azimuth of a satellite if a 
compass is not to hand or local magnetic fields are affecting it’s reading.  Both 
tables share the same “Edit Solar Event Form’.

The input form entry in need of further explanation is labelled ‘Solar transit or 
satellite longitude’.

If you require a table of solar transit times, this entry should be identical to that 
entered for the site longitude.  That is to say, the times are calculated when the 
sun crosses the site’s local meridian.  This can be thought of as the longitude of a 
“virtual” satellite directly south of your location (north in the Southern 
Hemisphere).

On the other hand, if you require a table of times when the sun’s azimuth is the 
same as that of a target satellite, from your location, then that satellite’s longitude 
or orbital slot should be entered instead.  Satmaster Pro will automatically detect 
which has been entered and display the appropriate table.

Calculate Menu
Here there are several modules to perform commonly required calculations and 
conversions such as, noise temperature to noise figure, degrees and minutes to 
degrees, wavelength to frequency etc. Click 'OK' button to recalculate or 'Cancel' 
to terminate.

Expression Evaluator
The expression evaluator (under the ‘Calculate’ menu) allows you to evaluate a 
mathematical expression entered as a string of characters to a numerical result.

The operator precedence is as follows
- Negate

           * Multiply
/ Divide

          + Add
- Subtract

    ^ Raise to the power
You may override the normal operator precedence with parentheses.  For 
example: f=(b+c)/a forces b+c to be evaluated before dividing by a.

The following functions are supported; the arguments must be enclosed in 
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parentheses.  For example sin(45).  With trigonometric functions, you can select 
either degree or radian mode by selecting the appropriate radio button.

abs absolute value
acos arc cosine (inverse cos)
asin arc sin (inverse sin)
atan arc tan (inverse tan)
cos cosine
cosh hyperbolic cosine
exp exponential
log logarithm (base 10)
logt logarithm (base 2)
ln logarithm (base e)
sin sine
sinh hyperbolic sine
sqr square root
tan tangent
tanh hyperbolic tangent

The constant 3.14159258 is entered into an expression as either ‘pi’ or ‘p’.

Window Menu
This menu helps you organize the application’s windows.  Choosing ‘Cascade’ 
arranges all open windows in a staggered and overlapped fashion.  Choosing 
‘Tile’ shrinks and arranges all open windows into a tile design either vertically or 
horizontally as requested.  If ‘Arrange Icons’ is selected it tidies up and arranges 
all the minimized icons at the bottom of the main application window.  ‘Close All’ 
closes all open windows and leaves a clear application window.  There are also 
toolbar buttons for ‘Cascade’ and ‘Tile Vertically’.

Help Menu
Selecting “Help Contents” offers more detailed information on how to use 
Satmaster Pro Pro and background information on various technical and practical 
topics.  

Copying Output to Spreadsheet Programs
The entire contents of a window may be copied to the clipboard in a single 
operation as tab delimited text. By selecting “Edit|Copy” or clicking the toolbar’s 
copy button.  Output can be pasted directly into a spreadsheet application, such 
as Excel, for customisation with minimal formatting.

Drag and Drop
Satmaster Pro supports the drag and drop standard of loading its file types into 
the main application windows. Windows shell features, such as “open” and “print” 
are enabled.

Most Recently Used Files
Under the ‘files’ menu there is a list of the six most recently used files.  This 
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enables quick opening of any of these files without the need to bring up the open 
file form. 

How To Prepare Paired Carrier Link Budgets.
For the fearless, these differ significantly from regular link budgets. Paired Carrier 
is an adaptive cancellation technology that allows two carriers to simultaneously 
occupy the same transponder bandwidth. Paired carriers are affected by the 
same interference and atmospheric factors as normal carriers.  Although there is 
degradation with each of the pair due to interference between the two, significant 
bandwidth savings may be possible. These link budgets can be prepared using 
the following guide:

1. Using File|New from main menu, open two Link Budget instances so you 
have a separate link budget for each direction inbound and outbound to 
hub.

2. Enter all the usual link budget (LB) input parameters paying special 
attention to the 'Implementation loss' input field under the 'Carriers' tab. 
Your modem manufacturer may supply guidance on the relevant values to 
enter for the extra degradation to be expected with paired carrier 
arrangements.

3. Screen resolution permitting, you may arrange the two link budget 
windows, inbound and outbound, side by side using 'Window|Tile 
Vertically' from the main menu.

4. The balancing of the two link budgets is a manual iterative process which 
is dependent on the initial results. A number of parameters (G/T, FEC and 
modcod) may be changed in an attempt to make the link more bandwidth 
limited and less power limited. 

5. Whenever a change is made then the two link budgets are run again to 
check the wanted to interferer beam peak EIRP densities are within about 
± 7dB of each other and the symbol rate ratio of the two carriers should be 
a maximum of 3:1 or 1:3 .There is an optional input provided for 
transponder beam peak EIRP for calculating the densities.
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